BASINS/HSPF Training Exercises

Exercise 10 — Bacteria and Temperature Modeling
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Management orart e
Strategy Setup Validation Validation

In this exercise, we will add temperature and fecal coliform to the calibrated WinHSPF
hydrology model. We will discuss: 1.) Using the Bacterial Indicator Tool to estimate
coliform buildup and washoff parameters; 2.) Adding temperature to the hydrology model;
3.) Adding fecal coliform to the hydrology model using the estimated input parameters from
the Bacterial Indicator Tool; and 4.) Calibrating temperature and fecal coliform.

Questions addressed in this section:

1.) How do | use the Bacterial Indicator Tool to estimate accumulation rates and limits
for fecal coliform on various land use segments?

2.) How do I add temperature and fecal coliform to my calibrated hydrology model?

3.) Which parameters do | adjust to calibrate temperature and fecal coliform bacteria?

A. Use Fecal Bacterial Tool to Estimate Fecal Coliform Loadings

QUESTION ANSWERED:
1.) How do I use the Bacterial Indicator Tool to estimate accumulation rates and limits for
fecal coliform on various land use segments?

The Bacterial Indicator Tool is a Microsoft Excel-based program that estimates loadings of
fecal coliform based on literature values of bacterial counts from animal populations. We
will discuss most aspects of the tool briefly, but because of time constraints, we have already
entered most of the information for you. Many explanations have been added to this exercise
and are taken directly from the “BacteriaTool.pdf”” (found in c:\basins\modelout\bacteria),
which provides full documentation of the tool.

1. From the Start menu under Programs, select Microsoft Excel.

~a

2. Click =] (Open File).

3. Navigate to c:\basins\modelout\bacteria\ and select “Patuxent Fecal Tool.xls.”” Click
OPEN.

Note: Spreadsheet entries in red font are to be set or modified by the user. Black font

denotes values calculated by the formulas in the spreadsheet. Blue font is used
for descriptive notes.
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At the bottom of your screen, there are 13 tabs. Click the first tab, named “Land
Use.”

Note: The spreadsheet considers only four land use types: Built-up, Forest, Cropland,
and Pastureland. The land use categories in the Patuxent model must be
mapped to these as follows:

Forest (PERLND 101) - Forest
Urban (PERLND 102) - Built-up
Agriculture (PERLND 103) - Cropland

We will not assign “Barren” to any of these land uses since its characteristics
are significantly different from the available land use options in the tool.
Instead we will use accumulation rates slightly lower than those for Forest
when we enter the values computed by the Bacterial Tool into WinHSPF. We
will assume that the inputs for the wetlands land use will be slightly less than
agriculture due to the number of waterfowl within in the area.

The following section explains how to populate the “Land Use” worksheet given the
information available in the WinHSPF model. We will open WinHSPF to obtain some
information and then we will return to the Bacterial Indicator Tool.

5.

6.

From the Start menu under Programs, select BASINS and then WinHSPF.
From the File menu, select Open.
Navigate to c:\basins\modelout\Bacteria and select “bacteria.uci.” Click OPEN.
Note: This *.uci file is the calibrated hydrology version of the model that has been
renamed for this exercise so we can add temperature and bacteria and keep a
clean copy of the calibrated hydrology file.
In the WinHSPF interface, click on the “RCHRES 17, ! REHREST 4 segment in the
watershed schematic (it should now be highlighted blue in the background).
Make sure the “Land Surface” tab (on the left) is selected and select the “Forest
Land”, “Urban or Built Up Land”, and “Agricultural Land” land use categories. The
area corresponding to Reach 1 will appear in the auxiliary table below the watershed
schematic. The auxiliary table should look like the following:
Land TUse |Reaches |Implnd lAores) |Perlnd lhores) |T|:utal lhores)
Forest Land ECHEES 1 oo LEyak.0 Eyat.no
Urban or Built-up La ERCHEES 1 Zg830.0 Za30.0 Ega0_0
Agricultural Land ECHEES 1 oo Gz55.0 gz55.0
Total Z830.0 14570.0 177000

Note: The areas reported in the auxiliary table shown above represent the pervious
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and impervious land segment areas (separated out by land use) that are
draining to RCHRES 1.

10. Toggle to the Bacterial Indicator Tool (i.e., the Excel spreadsheet) and make sure that
the “Land Use” tab is selected. Notice that the Bacterial Indicator Tool allows up to
10 subwatersheds (P1 — P10). Since our subbasin has six subwatersheds, we will use
only P1 through P6, corresponding to subwatersheds 1 through 6, respectively.

11. Enter the areas from the auxiliary table in WinHSPF into the cells corresponding to
P1. Your screen should look like the following:

Areas are listed in acres.

SUBWATERSHED BUILT-UP CROPLAND PASTURELAND FOREST TOTAL

P1 aEaE0 G255 4785 17700
P2 0
P3 0
P4 0
P5 0
P6 0
P7

P8

P9

P10

TOTAL 5660 6255 1] 5785 17700

Note: Notice that the value entered for “Built-Up” was the sum of the Urban or Built
Up Land impervious and pervious land segment area.

12. Repeat step 8-11 for all the reaches (6 total). Make sure you only have one reach
selected at a time (highlighted blue in the background). You can unselect a reach by
clicking on it again. When you have completed these steps for each reach, your
screen should look like the following:

Areas are listed in acres.

SUBWATERSHED BUILT-UP CROPLAND PASTURELAND FOREST TOTAL

P1 5660 6255 5785 17700
P2 4776 8870 6048 19694
P3 972 1483 1873 4328
P4 A60 225 840 1625
P5 164 164
P& 1282 4569 27 4 8623
P7 0
P& 0
P9 0
P10 0
TOTAL 13414 21402 0 17320 52136

In the following section, we will view and briefly discuss each sheet in the tool. Remember
that the discussion is taken primarily based on information available in the Bacterial
Indicator Tool User’s Guide (referenced below). As mentioned previously, all of the
numbers for the West Branch Patuxent have already been entered due to time constraints.

13. Click on the “Animals” tab and look over the required inputs.

Note: In this sheet, the user specifies the number of various animals in the subbasin.
Livestock are entered in number per watershed (total population), and wildlife
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are entered as number / sq. mile. Finding livestock population and wildlife
density data can be difficult. Many states conduct informal livestock counts
and wildlife management groups sometimes have wildlife density estimates
for certain areas. You may need to make guesses based on available estimates
from other, similar watersheds.

=lalx
A B C D E | F [ G o

| 1 |The total numher of animals in the 10 subwatersheds is shown bhelow. =
2

I Fecal contributions from these animals are used to derive loading estimates for all landuses except for Built-up.

| 4 |Only manure from cattle, swine, and poultry is assumed to be collected and applied to cropland. Cattle manure is

| 5 [Manure from cattle, horses, sheep and "other” is assumed to he contributed to pastureland in proportion to time sy

| B [Wildlife densities are provided for all land uses except Built-up and are assumed to be the same in all subwatersh
7

E Agricultural Animals

| 3 |SUBWATERSHED BEEF CATTLE  SWINE (HOGS) DAIRY CATTLE  CHICKENS HORSES SHEE

| 10 |P1 156 120 3 96 45

|11 P2 192 148 38 118 75

|12 |P3 43 34 9 28 15

|13 P4 14 10 3 9 5

| 14 |P5 0 1] 0 0 0

| 15 |P6 95 73 19 59 25

| 16 |P7 0 1] 0 0 0

|17 |P8 0 1] 0 0 0

|18 |P9 0 1] 0 0 0

| 19 P10 0 1] 0 0 0

| 20 |[TOTAL 500 385 100 310 165

1 21 |

| 22 |

| 23 |Wildlitfe

| 24 | CROPLAND CROPLAND  PASTURELAND PASTURELAND FOREST

| 25 | Animals/sg mile Density/acre  Density’sq mile  Density’acre  Density/’sq mile

| 26 [Ducks 10 0.015625 0 0 20

| 27 [Geese 5 0.0078125 0 0 10

| 25 [Deer 5 0.0078125 0 0 5 0.

| 25 |Beaver 1 0.0015625 0 0 2 0.0
201D 2 nnn3i3s n n [ n

14 [ 4 » [ M Land Use % Animals { Manure Application Grazin References 4 Wildife £ Cropland 4 Forest £ Built-y Pasturelejiélb “ A

14.

15.

16.

Click the “Manure Application” tab and look at the required inputs.

Note: The Manure Application worksheet calculates the fraction of the annual
manure produced that is available for washoff based on the amount applied to
cropland and pastureland in each month and the fraction of manure
incorporated into the soil (for hog, beef cattle, dairy cattle, horse, and poultry
manure).

Click the “Grazing” tab and look at the required inputs.

Note: The Grazing worksheet lists the days spent confined and grazing for beef
cattle, horses, sheep, and other. Beef cattle are assumed to have access to
streams while grazing.

Click the “References” tab and look through the worksheet.

Note: The Reference worksheet lists literature and assumed values for manure

content, wildlife densities, and built-up fecal coliform accumulation rates.
These values are used in calculations in the remaining worksheets.
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17.

18.

19.

20.

21.

22,

23.

24,

Click the “Wildlife” tab and look through the worksheet.

Note: The Wildlife worksheet calculates the fecal coliform bacteria produced by
wildlife by land use category. The calculations are based on the animal
population and densities specified in the Animal worksheet.

Click the “Cropland” tab and look though the worksheet.

Note: The Cropland worksheet calculates the monthly rate of accumulation of fecal
coliform bacteria on cropland from wildlife, hog, cattle, and poultry manure.

Click the “Forest” tab and look through the worksheet.

Note: The Forest worksheet calculates the rate of accumulation of fecal coliform
bacteria on forestland from wildlife.

Click the “Built-up” tab and look at the required inputs.

Note: The Built-Up worksheet calculates the rate of accumulation of fecal coliform
bacteria on built-up land using literature values. No distinction is made
between pervious and impervious land. Because the bacterial tool breaks
down urban land rather differently than the land use classifications in
WInHSPF, the divisions in the spreadsheet have been left at default values for
this exercise.

Click the “Pastureland” tab and look through the worksheet.

Note: The Pastureland worksheet calculates the monthly rate of accumulation of
fecal coliform bacteria on pastureland from wildlife, cattle, and horse manure,
and cattle, horse, sheep, and other grazing.

Click the “Cattle in Streams” tab and look through the worksheet.

Note: The Cattle in Streams worksheet calculates the monthly loading and flow rate
of fecal coliform bacteria contributed directly to the stream by beef cattle.

Click the “Septics” tab and look through the worksheet.

Note: The Septics worksheet calculates the monthly loading and flow rate of fecal
coliform bacteria from failing septic systems. The user must provide an
estimate of the number of septics in the area, and the number of people served
by the septics. The sheet uses these values and literature values for flow rates
and coliform concentrations in overflows.

Click the “ACQOP&SQOLIM (for land uses)” tab and look through the worksheet.

Note: This worksheet summarizes the monthly rate of accumulation (used for the
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HSPF parameter(s) ACQOP/MON-ACCUM) of fecal coliform bacteria on the
four land uses and calculates the build-up limit (used for the HSPF
parameter(s) SQOLIM/MON-SQOLIM) for each land use. The following
section details where these values should be entered within the WinHSPF
interface.

B. Modeling Bacteria in WinHSPF

QUESTION ANSWERED:
2.) How do I add temperature and fecal coliform to my calibrated hydrology model?

In this section, we will return to WinHSPF and add temperature and fecal coliform to the
WIinHSPF model. WinHSPF handles fecal coliform in a general manner; using modules that
can be applied to any constituent by modeling fate and transport simplistically (e.g., first
order decay, etc.). This will be explained further throughout the section.

1. If WinHSPF isn’t already open, from the Start menu under Programs, select
BASINS and then WinHSPF.

2. From the File menu, select Open.

3. Navigate to c:\Basins\Modelout\Bacteria and select “bacteria.uci.”” Click OPEN.
NﬁIlIa, H

4, Click the “Pollutant Selection” button, | ¥ tu

5. Click “F.COLIFORM” and “WATERTEMP” in the “Available” window while
holding the “Ctrl” key down.

6. Click ADD.

Note: “F.COLIFORM” and “WATERTEMP” should appear in the “Selected”
window.

7. Click OK.

Note: Appendix F explains what occurred when “F.COLIFORM” and
“WATERTEMP” were selected within the “Pollutant Selection” tool and how
to manually complete the same task. This information is included to help the
user: 1.) Better understand how WinHSPF handles different constituents, and
2.) Ensure that the model is doing what the user wants. In short, when using
the “Pollutant Selection” tool the required “Control Cards” are selected, the
corresponding tables are added for each constituent selected, and the
appropriate mass-links are added. Additionally, some of the fields within the
tables were updated with required information. We will look at the control
cards that were automatically added, open some of the key tables, and discuss
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10.

11.

12.

some of the key required inputs.

-

Click the “Edit Control Cards” button, L=~

Click DESCRIPTIONS.

Make sure the “Pervious Land” tab is active. Notice the boxes beside ATEMP,
PSTEMP, PWTGAS and PQUAL are now checked.

ATEMP - Module that estimates the surface air temperature over the land segment by correcting for
elevation differences between the gage and the land segments.

PSTEMP - Module that simulates soil temperatures for the surface, upper, and lower/groundwater
layers of a land segment for use in module section PWTGAS and the agri-chemical sections.

PWTGAS - PWTGAS estimates water temperature and concentrations of dissolved oxygen and carbon
dioxide in surface, interflow, and groundwater outflows from a land segment.

PQUAL - Module that simulates water quality constituents or pollutants in the outflows from a
pervious land segment using simple relationships with water and/or sediment yield. Any
constituent can be simulated by this module section. However, more detailed methods of
simulating sediment, heat, dissolved oxygen, dissolved carbon dioxide, nitrogen, phosphorus,
soluble tracers, and pesticide removal from a pervious land segment are available, in other
module sections.

Note: ATEMP, PSTEMP, and PWTGAS were turned on when “WATERTEMP”
was selected in the “Pollutant Selection” tool. PQUAL was turned on when
“F.COLIFORM” was selected in the “Pollutant Selection” tool.

Click the “Impervious Land” tab. Notice that ATEMP, IQUAL, and IWTGAS are
now selected.

ATEMP - Module that estimates the surface air temperature over the land segment by correcting for
elevation differences between the gage and the land segments.

IWTGAS - IWTGAS estimates the water temperature and concentrations of dissolved oxygen and
carbon dioxide in the outflow from the impervious land segment.

IQUAL - The IQUAL module section simulates water quality constituents or pollutants in the outflows
from an impervious land segment using simple relationships with water yield and/or solids. Any
constituent can be simulated by this module section. Note that more detailed methods of simulating
solids, heat, dissolved oxygen, and dissolved carbon dioxide removal from the impervious land
segment are available in other sections of IMPLND.

Note: ATEMP and IWTGAS were turned on when “WATERTEMP” was selected in
the “Pollutant Selection” tool. IQUAL was turned on when “F.COLIFORM”
was selected in the “Pollutant Selection” tool.

Click the “Reaches/Reservoirs” tab. Notice the boxes beside ADCALC, HTRCH, and
GQUAL are now selected.

ADCALC - Module that calculates values for the variables necessary to simulate longitudinal
advection of dissolved or entrained constituents. These variables are dependent upon the volume
and outflow values calculated in the hydraulics section (HYDR).

HTRCH — Module that simulates the processes that determines the water temperature in a reach or
mixed reservoir.
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13.

14.

GQUAL - Module that allows the model user to simulate the behavior of a generalized constituent.
The constituent which is modeled may be present in the RCHRES only in a dissolved state, or it
may also be sediment-associated.

Note: HTRCH was turned on when “WATERTEMP” was selected using the
“Pollutant Selection” tool. ADCALC and GQUAL were turned on when
F.COLIFORM was selected in the “Pollutant Selection” tool.

Click OK.

Click the “Input Data Editor” button, H Take some time to look through the
tables that are associated (and automatically added (in bold)) with each newly
selected module. An outline of the tables and parameters associated with these
modules are included at the end of the exercise. It is critical to understand how the
tables within each module relate to each other. Additionally, it is important to
understand how flags set in one table predict the required inputs in another.

In the next section, we will look at a few of the inputs that were automatically populated
when using the “Pollutant Selection” tool.

PERVIOUS LAND

PQUAL

1.

Double click PERLND - PQUAL - NQUALS. Click OK if asked whether to add
the table. Notice that the value for NQUAL is “1” for each pervious land segment.
This specifies that we will model one general quality constituent, fecal coliform.

# _Edit PERLND:NQUALS =]

¥ Show Description

OpMum | Description MNELAL

m Forest Land 1

102 Urban or Built-up La 1

103 Agricultural Land 1

104 Barren Land 1

105 ‘Wwetlands 1

Table: NQUALS, The total number of quality constituents simalated in section d

PQUAL is indicated in this table.

Parameter: NQUAL is the total number of cquality constituents.

*** <DPLS =

*** x - xNQUAL LI
oK Lancel Apply | Help |

Click OK or CANCEL.

Double click QUAL-PROPS. Notice that the QUALID (constituent name) and
QTYID (units of constituent) columns were automatically populated for you when
you selected F.COLIFORM in the “Pollutant Selection” tool. Also notice that fecal
coliforms are assumed to be associated with overland flow (QSOFG), interflow
(QIFWFG), and groundwater (QAGWEFG) by these flags being turned on (set to 1)
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automatically. See definitions in outline at the end of the exercise for clarification of
each of the flags in this table.

OpMurm| Description |QuslD | OTYID| OSDFG | YPPwFG|¥PFSFG| D50FG| YOOFG| QIFWFG] VIDCFG | DAGWFG | ¥ALCFG

101 Forest Land F.COLIFORM HORG 0 0 0 1 1 1 1 1 1

102 Urhan or Buitup Le F.OOLIFORM #0RG i 1 1 1 1

103 Agricubural Land  F.COLIFORM #ORG 0 i i 1 1 1 1 1 1

104 Bamen Land F.COLIFORM HORG 0 i i 1 1 1 1 1 1

105 ‘wetlands F.COLIFORM HORG 0 i i 1 1 1 1 1 1
4. Click OK.

5. Double click QUAL-INPUT. Read the following parameter explanations:

SQO: The initial storage of QUALOF on the surface of the PLS.

POTFW: The washoff potency factor for a QUALSD. A potency factor is the ratio of constituent yield
to sediment (washoff or scour) outflow.

POTFS: The scour potency factor for a QUALSD. A potency factor is the ratio of constituent yield to
sediment (washoff or scour) outflow.

ACQORP: The rate of accumulation of QUALOF if QSOFG is positive. If QSOFG is negative, then
ACQORP is the concentration of QUALOF in the surface outflow in mg/I.

SQOLIM: The maximum storage of QUALOF if QSOFG is positive.

WSQOP: The rate of surface runoff that will remove 90 percent of stored QUALOF per hour.

10QC: The concentration of the constituent in interflow outflow (meaningful only if this is a QUALIF).

AOQC: The concentration of the constituent in active groundwater outflow (meaningful only if this is a
QUALGW)

Although these definitions can be confusing and difficult to keep track of, it is helpful to
begin to understand the acronyms and abbreviations used within WinHSPF. In the above
definitions, QUALOF stands for the “Quality associated with Overland Flow,” QUALSD
stands for the “Quality associated with Sediment,” QUALIF stands for the “Quality
associated with InterFlow,” etc.

The values determined for ACQOP (accumulation of constituent) and SQOLIM (storage
limits of constituents) in the Bacterial Indicator Tool can be entered in this table if you
choose to use an annual average value. In this case, however, when using the “Pollutant
Selection” tool to add fecal coliform to our model, the monthly flag for accumulation and
storage was automatically turned on (VQOFG value set to “1”). This means that the model is
expecting the user to enter the monthly values for ACQOP and SQOLIM calculated in the
Bacterial Indicator Tool into the MON-ACCUM and MON-SQOLIM tables respectively.

Remember that the Bacterial Indicator Tool provided us with monthly values for ACQO and
SQOLIM for each subwatershed for both Cropland and Pastureland. Average yearly values
were produced for Forest and Built-Up land by the Bacterial Indicator Tool. This tool
assigns these values for each land use category within each subwatershed. The West Branch
Patuxent model currently has not been segmented, meaning that separate parameter inputs
are not allowed for individual subwatersheds. We are therefore required to use an average
monthly or annual ACQO and SQOLIM value across subwatersheds for each land use
category.

6. Click OK.
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IMPERVIOUS LAND

IQUAL

1.

6.

Double click IMPLND - IQUAL - NQUALS. Notice that the value in the
“NQUAL” column is “1.” This specifies that we will model one quality constituent.

# _Edit IMPLND:NQUALS - O] x|
v Show Description
OpMum | Dezcription MEAL
1m Idrban ar Built-up La 1
Click CANCEL.
Double click QUAL-PROPS. Notice that QUALID and QTYID are already
populated.
# _Edit IMPLND:QUAL-PROPS =10 x|

[ Show Description

Oezcurence |1 vI

OpMum | Description |QusLD  |eTvID | BSDFG|  WPPWFG|  QSOFG|  WOOFG
10 Idiban or Built-up La F. Coli #ORG 1] 1] 1 1]

Click OK.

Double click QUAL-INPUT. The parameters in this table are similar to those in the
PQUAL-> QUAL-INPUT table. The difference is that the quality constituent(s)
cannot be associated with interflow and groundwater since impervious land does not
include these hydrologic components.

In this table, we used the values for accumulation (ACQOP) and storage limits
(SQOLIM) from the Bacterial Indicator Tool for Built-Up and Urban land and
entered them into this table.

Click OK.

REACHES AND RESERVOIRS

GQUAL

1.

2.

Double click RCHRES - GQUAL-> GQ-GENDATA.

Double click GQ-GENDATA. The following screen will appear. Notice that the
values in the “NQUAL” column are all “1.” This means that we will model one
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quality constituent.

. Edit RCHRES:GQ-GENDATA =10] x|

[ Show Description

DpMum | Description | NGOUAL| TEMPFG| PHFLAG| ROXFG| CLDFG| SDFG| PHYTFG| LAT
1 Wiestern Branch Patus 1 2 2 2 2 2 i
2 Southwest Branch YWes 1 2 2 2 2 2 2 i
3 South Collington Bra 1 2 2 2 2 2 2 i
4 South Reach, \Westem 1 2 2 2 2 2 2 i
a] “wiestern Branch Patus 1 2 2 2 2 2 2 1]
g Marth Collington Bra 1 2 2 2 2 2 2 I]

3. Click OK.

4. Double click GQ-QALDATA. Read the following explanations:

DQAL: The initial concentration of the quality constituent.

CONCID: Specifies the concentration units (implied that it is "per liter), e.g., "mg"(/l).

CONV: The factor to convert from Qty/volume to concentration units: Conc= CONV* Qty/volume (in
English system, volume is in ft%) (in Metric system, volume is in m°).

OpMum | Description | GRID | Doal|cONCID | CONY|GETYID
1 Western Branch Patus F.COLIFORM A0 OR/L 0.0353 #ORG
2 Sauthwwest Branch Wes F.COLIFORM A0 ORAL 00353 HORG
3 Sauth Callingtan Bra F.COLIFORM A0 ORAL 00353 HORG
4 South Reach, Western F.COLIFORM A0 ORAL 00353 HORG
3] Western Branch Patus F.COLIFORM A0 OR/L 0.0353 #ORG
E Horth Collington Bra F COLIFORM A0 ORAL 00353 HORG

All fields in this section were populated when “F.COLIFORM” was chosen in the
“Pollutant Selection” tool.

S. Click OK.

Now that the general constituent to be modeled has been identified and the units and required
conversions have been specified, we need to decide how this particular constituent will react
in the stream. Because we are modeling fecal coliform as a “dissolved constituent” (meaning
that the constituent is entrained in the water column and only decay processes are considered
if it is not associated with sediment), we can choose among many different decay options
including hydrolysis, oxidation, photolysis, volatilization, biodegradation, general first order
decay, and adsorption/desorption. The accepted practice for fecal coliform modeling is to
apply a first order decay rate with possible adsorption/desorption if sediment is being
concurrently modeled. When we selected “F.COLIFORM?” in the “Pollutant Selection” tool,
the first order decay rate option was automatically selected by setting a flag (QUALFG6
assigned a value of “1”) in the GQ-QUALFG table. Because this flag was set to “1,” the
GQ-GENDECAY (general first order decay) table was added. Sediment association is not
automatically assumed when using the “Pollutant Selection” tool. For more information
about modeling fecal coliform as sediment associated, please refer to the “Additional Notes”
section at the end of the exercise.
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6. Double click GQ-GENDECAY. Read the following explanations:

FSTDEC: The first order decay rate for the quality constituent.
THFST: The temperature correction coefficient for first order decay.

7. Click OK.

8. Click CLOSE.

C. Calibrating Temperature and Fecal Coliform

QUESTION ANSWERED:
3.) Which parameters do | adjust to calibrate temperature and fecal coliform bacteria?

In previous sections, you were not required to enter or change any values within all the
newly added tables. Recall that default values are almost always provided for required
inputs; however, most of the inputs require updating with local information. Appendix F
explains the values that should be updated as well as the procedure for doing this. In this
section, we will open a *.uci file that has all the required inputs including the monthly
accumulation and storage limitation values calculated within the Bacterial Indicator Tool.
We will run some scenarios, explain the key calibration parameters, and discuss management
options that will help shareholders comply with the instream water quality standard.

1. From the File menu in WinHSPF, select Open.
2. Click OK when informed that you can only have one .uci active.
3. Navigate to c:\basins\modelout\bacteria\ and select “Bact_2.uci.” Click OPEN.

Note: This new *.uci file contains all the monthly tables mentioned in previous steps.

4. Click the “Output Manager” button, rE:

5. Click the button beside “Other.”
6. Click ADD.
7. In the “Operation” frame, select “RCHRES 5 (Western Branch Patuxent).”

8. In the “Group/Member” frame, select “GQUAL:DQAL(1,1).” Your screen should
look like the following:
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#_ WinHSPF - Add Dutput =]
O peration: Group/Member:

FERLMD 105 [wetlands) ;I
IMPLMD 101 [Urban or Built-
RCHRES 1 MwWestern Branch
RCHRES & [Horth Collington
RCHRES 3 [South Callington
RCHRES 2 [Southwest Bran:

RCHRES 4 [South Reach, W T

MEEALDEALTT ]
GOUALSRALTI]
GOUALSGALIZT]
GOUALSGALIZT]
GOUAL:SGALET)
GOUALSRALRI]

HTRCH:HTCF4[E.1)
HTRCH:HTCF4[7 1

[

L

GARUAL:DAAL - Dizzolved concentration of qual. [concul]

WDHM Location 1D: IFH:HE

Baze WDM D5SH: |

ok |

1000

LCancel |

Note: By selecting GQUAL:DQAL (1,1) we are specifying that we want to see the
dissolved concentration in Reach 5 of the first general quality constituent we
are modeling (depicted by the first subscript).

9. Click OK.

10. In the “Operation” frame, select “RCHRES 5 (Western Branch Patuxent).”

11. In the “Group/Member” frame, select “HTRCH:TW.” Your screen should look like

the following:
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#_ WinHSPF - Add Output ]|

O peration: Group/Member:
FERLMD 105 [wetlands) ;l HYDR:TAL ;l
IMPLMD 107 [Urban ar Built- HYDR:RO
RCHRES 1 MwWestern Branch HYDR:PRSUFY —
RCHRES & [Morth Collington HYDR:MOLEY
RCHRES 3 [Sauth Callingtan HYDR:ROYOL
RCHRES 2 [Southwest Bran: (HTHECH: T
55 HTRCH:AIRTHMP
RCHRES 4 [South Reach, W T HTRCH:HTE=CH ;I

HTRCH: T - Simulated water termperature in RCHRES [DegF]

WDHM Location 1D: IFH:HE
Base WDM DSN: | 1000

(1] | LCancel |

Note: By selecting HTRCH:TW, we are specifying that we want to see the simulated
water temperature (° Fahrenheit) in Reach 5.

12.  Click OK. The “Output Locations” frame for “Other” should look like the following:

Output Locations:
| Group/Member |
GOUAL:DOAL
HTRCH: T

N arne | Description
RCHRESS . Wwestern Branch Patux
‘estern Branch Patus

13.  Click CLOSE.

14.  Click =l (Run HSPF).

15.  Click SAVE/RUN.

16.  Click ﬁ (View Output through GENSCN).

17.  Click the “HSPF Output” tab.
18.  Check the box beside “Bact_WB.wdm.”
19.  Click OK.

20. In the “Scenarios” frame, select “BACT_2.”
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21.

22,

23.

24,

25.

26.

217.

28.
29.

30.

31.

32.

In the “Constituents” frame, select “DQAL1.”

Click the “Add to time series list” button,

Select the DQAL time series.

Click the “Generate Graphs” button, 'llll

Click GENERATE. Your plot should look like the following:

15000

13500 ]
L2000 —
o500 ]

Qoo - —

Ta00 - -

DOAL

G000 -
4500 —
3000 —

1500

1026 1927 19a2 1020

EACT_2 DQAL & ECHS

Close the plot and the “Graph” window. Toggle to GenScn.
In the “Scenarios” frame, select “OBSERVED.”

In the “Constituents” frame, select “TW.”
Click the “Add to time series list” button, +

Select both the observed and simulated TW time series.

Click the “Generate Graphs” button, 'IIII

Click GENERATE. Your plot should look like the following:
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33.  Close the plot and the “Graph” window.

Calibrating Simulated Temperature

In this following section, we will discuss simulated temperature calibration in our model.
Many parameters can be adjusted in temperature calibration, including PSTEMP (ASLT,
BSLT, ULTP1, ULTP2), IWTGAS (AWTF, BWTF) and RCHRES (KATRAD, KCOND,
KEVAP, etc.) Although the PSTEMP and IWTGAS parameters can be very important, in
general, the amount of surface flow is small relative to that within the stream channel. This
means that the temperature of the overland flow will generally will quickly come into a
dynamic equilibrium with the instream flow (without drastically changing the instream
temperatures) due to the heat capacity within the stream being much larger than that in the
surface flow. The RCHRES parameters KATRAD, KCOND, EVAP, and CFSAEX are
generally the most important calibration parameters. CFSAEX is a key parameter because it
attempts to capture (or make up for) the large variability in the amount of solar radiation
actually reaching the stream. For smaller, shallower streams, there are some additional
optional bed sediment heat transfer processes that may be necessary to implement to account

for higher temperatures.

Additional options for calibrating temperature besides parameter adjustment include:
e Increasing detail in the lower flow portions of the F-table so that during extremely
low flow events realistic water depths are present. If there is inadequate resolution in
the F-tables for low flows, it is possible for the model to become unstable and predict

temperatures erroneously.

e Adjusting the weather data by adding a multiplicative factor or possibly finding more

representative data for the area being modeled.

Given this information, we will attempt to calibrate temperature in the Western Branch
Patuxent model. Because of time constraints, we will vary only CFSAEX. The general
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calibration procedure should be to (a) examine hourly temperature values to ensure there are
only reasonable values, (b) focus the calibration efforts on ensuring daily averages are
accurate, and (c) if detailed data are available, adjust parameters to ensure the model is
predicting the maximum and minimum temperatures accurately. In this exercise, we will not
look at the hourly output. Instead we will focus on step (b) mentioned above.

Note: In order to inspect the hourly output in GenScn, you must add an External
Target in the EXTERNAL TARGETS do this by (a) opening the EXT
TARGETS block within the “Input Data Editor” (there should only be the two
output time series you selected in the “Output Manager” in the table), (b)
clicking ADD, (c) copying the information from the already existing TW
timeseries with the exception of the value for the “Volld”! column (this
column contains the DSN number which needs to be one greater than the DSN
numbers already in the EXTERNAL TARGETS), and (d) clicking APPLY.
An “Add Data Set” window will appear in which you will need to change the
“Time Units” column from “4” (daily output) to “3” (hourly output).

34.  Close the plot and the “Graph” window.

35. Plot both the observed and simulated temperature for 1986, 1987, and 1988
individually. You will see that we are consistently under-predicting water
temperatures.

Spend some time calibrating temperature by adjusting CFSAEX (RCHRES - HTRCH = HEAT-
PARM) between 0 (completely shaded) and 1 (completely exposed). See how close you can
get the simulated daily average values to the observed daily average values.

Calibrating Fecal Coliform

Since there are no observed fecal coliform data for comparison and/or calibration, we will
make parameter adjustments to observe the effects and sensitivity of various parameters. We
will focus on a subset of the output to simplify this activity. Key calibration parameters are:

ACQOP - Accumulation rate (PERLND & IMPLND). (PERLND = PQUAL - MON-ACCUM)
SQOLIM - Storage limits (PERLND & IMPLND). (PERLND - PQUAL - MON-SQOLIM)
FSTDEC - First order decay coefficient. (RCHRES>GQ-GENDECAY)

To determine a range of reasonable estimates for the accumulation (ACQOP) and storage
limit (SQOLIM) inputs, it might be helpful to return to the Bacterial Indicator Tool and
change the animal populations in the spreadsheet that were most uncertain, change the septic
tank population and/or failure rates in the spreadsheet if uncertain estimates were used, or
change built-up fractions to more closely reflect the breakdown between Residential and
Industrial/Transportation subcategories. For the purposes of this exercise, you may want to
spend some time changing the accumulation and storage limit parameters to help you
understand the effects the adjustments.

1 There are 2 “Volld” columns. Click in both “Volld” columns to determine which one corresponds to the Data
Set Number (or DSN) given the information provided in the information box below the table.
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Running Scenarios

Now that you have “calibrated” the temperature and fecal coliform, scenarios can be run.
Assume that the fecal coliform standard states that organism levels shall not exceed a
threshold of 400 colonies/100 mL. Try to identify management options (using parameter
adjustments) to ensure that there will be no exceedance of this standard. Suggestions include
changing the land use distribution, decreasing livestock in the area, decreasing application of
manure, scaring all the geese into the neighboring drainage, etc.

Additional Notes

Current research suggests that the association of coliform with sediment is strong in many
areas. Assuming sediment was simulated, you could turn “on” instream sediment association
by setting the flag SDAS (QALFG(7)) in table GQ-QALFG to “1,” allowing for the coliform
to adsorb and desorb sediment both in the water column and in the bed. In this situation,
important parameters are the partition coefficients in the water column and bed (table GQ-
KD); adsorption rate parameters (table GQ-ADRATE); adsorption temperature correction
coefficients. (table GQ-ADTHETA); and decay rates for sorbed bacteria (GQ-SEDDECAY).

Reference:

Sauer, J. R., B. G. Peterjohn, S. Schwartz, and J. E. Hines. 1995. The Grassland Bird Home
Page, Version 95.0. Patuxent Wildlife Research Center, Laurel, MD.

http://www.epa.gov/maia/html/mda-live.html Sept. 11, 2002

1990 US Bureau of Census Sept. 11, 2002
www.nass.usda.gov/md/mp-40-99.pdf Sept. 11, 2002

USEPA, 2000. Bacterial Indicator Tool: User’s Guide. EPA-823-B-01-003. Washington,
DC: Office of Water
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TEMPERATURE & BACTERIA INPUTS

PERVIOUS LAND

ATEMP Module that estimates the surface air temperature over the land segment by correcting for
elevation differences between the gage and the land segments.

ATEMP-DAT (ATEMP Data)

ELDAT: The difference in elevation between the temperature gage and the previous land segment; it is
used to estimate the temperature over the pervious land segment by application of a lapse rate. It
is positive if the pervious land segment is higher than the gage, and negative if the land segment is
lower than the gage.

AIRTMP: The initial (i.e., at the starting time of the RUN) air temperature over the land segment.

PSTEMP Module that simulates soil temperatures for the surface, upper, and lower/groundwater layers of
a land segment for use in module section PWTGAS and the agri-chemical sections.

PSTEMP-PARM1 (Soil Temperature Simulation Flags)

SLTVFG: If this is 1, parameters for estimating surface layer temperature can vary monthly.

ULTVFG: If this is 1, parameters for estimating upper layer temperature can vary monthly.

LGTVFG: If this is 1, parameters for estimating lower layer and active groundwater layer
temperature calculations can vary monthly.

TSOPFG: Governs the methods used to estimate subsurface soil temperatures. If TSOPFG is 0, they
are computed using a mean departure from air temperature, together with smoothing factors. If
TSOPFG is 1, upper layer soil temperature is estimated by regression on air temperature (like
surface temperature). The lower layer/groundwater layer temperature is supplied directly by the
user (a different value may be specified for each month). If it is 2, the same method is used as for
a value of 0, except that the upper layer temperature is used instead of the air temperature to
compute the lower layer/groundwater layer temperature.

PSTEMP-PARM2 (Soil Temperature Estimation Inputs)

ASLT: The surface layer temperature when the air temperature is 32 degrees F (0 degrees C). Itis
the intercept of the surface layer temperature regression equation.

BSLT: The slope of the surface layer temperature regression equation.

ULTP1: The smoothing factor in upper layer temperature calculation, if TSOPFG =0 or 2. ULTP1 is
the intercept in the upper layer soil temperature regression equation (like ASLT and BSLT for the
surface layer), if TSOPFG = 1.

ULTP2: The mean difference between upper layer soil temperature and air temperature, if TSOPFG =
0 or 2. ULTP2 is the slope in the upper layer soil temperature regression equation (similar to
ASLT and BSLT for the surface layer), if TSOPFG = 1.

LGTP1: The smoothing factor for calculating lower layer/groundwater soil temperature, if TSOPFG =
0 or 2. LGTP1 is the lower layer/groundwater layer soil temperature, if TSOPFG = 1.

LGTP2: The mean departure from air temperature for calculating lower layer/groundwater soil
temperature, if TSOPFG =0 or 2. LGTP2 is not used if TSOPFG is 1.

PSTEMP-TEMPS (Soil Temperature Initial Conditions)
AIRTC: The initial air temperature.
SLTMP: The initial surface layer soil temperature.
ULTMP: The initial upper layer soil temperature.
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LGTMP: The initial lower layer/groundwater layer soil temperature.

PWTGAS Module that estimates water temperature and concentrations of dissolved oxygen and carbon
dioxide in surface, interflow, and groundwater outflows from a land segment.

PWT-PARML (Dissolved Oxygen and Carbon Dioxide Flags)
IDVFG: If IDVFG is 1, interflow DO concentration may vary monthly.
ICVFG: If ICVFG is 1, interflow CO2 concentration may vary monthly.
GDVFG: If GDVFG is 1, groundwater DO concentration may vary monthly.
GCVFG: If GCVFG is 1, groundwater CO2 concentration may vary monthly.

PWT-PARM2 (Water Temperature and Gas Input Estimations)
ELEV: The elevation of the PLS above sea level (used to adjust saturation concentrations of dissolved
gasses in surface outflow).
IDOXP: The concentration of dissolved oxygen in interflow outflow.
ICO2P: The concentration of dissolved CO2 in interflow outflow.
ADOXP: The concentration of dissolved oxygen in active groundwater outflow.
ACO2P: The concentration of dissolved CO2 in active groundwater outflow.

PWT-GASES (Initial Conditions for DO and CO2 concentrations)
SODOX: The initial DO concentration in surface outflow.
SOCO2: The initial CO2 concentration in surface outflow.
I0DOX: The initial DO concentration in interflow outflow.
10CO: The initial CO2 concentration in interflow outflow.
AODOX: The initial DO concentration in active groundwater outflow.
AOCO2: The initial CO2 concentration in active groundwater outflow.

PQUA\L Module that simulates water quality constituents or pollutants in the outflows from a pervious land
segment using simple relationships with water and/or sediment yield.

NQUALS (Contains the number of quality constituents to be modeled)
NQUAL: The total number of quality constituents to be modeled.

QUAL-PROPS (1dentifiers and Flags for Quality Constituents)

QUALLID: A string of up to 10 characters that identifies the quality constituent.

QTYID: A string of up to 4 characters that identifies the units associated with this constituent (e.g., kg,
(for coliforms)). These are the units referred to as "qty" subsequent tables (eg. Table-type QUAL-
INPUT).

QSDFG: If 1, this constituent is a QUALSD (sediment associated).

VPFWFG: If 1, the washoff potency factor may vary monthly. If VPWFG is 2, the daily factors are not
interpolated between monthly values.

VPFSFG: If 1, the scour potency factor may vary monthly.

QSOFG: If 1 or 2, this constituent is a QUALOF (directly associated with overland flow). If 1, then
accumulation and removal are performed daily, and the removal rate is dependent only on the
accumulation and storage limit parameters (ACQ and SQOLIM). If 2, accumulation and removal
are performed every interval, and the removal rate also takes into account atmospheric deposition
plus lateral inflows.

VQOFG: If 1 then the rate of accumulation and the limiting storage of QUALOF may vary monthly.

QIFWFG: If 1 this constituent is a QUALIF (interflow associated).

VIQCFG: If 1 or greater, then the concentration of this constituent in interflow outflow may vary
monthly. If 2 or 4, no interpolation is used. If 3 or 4, units are mg/L. This requires QTYID to be
LB (English or KG (Metric).

QAGWEFG: If 1, this constituent is a QUALGW (groundwater associated).
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VAQCFG: If 1, the concentration of this constituent in groundwater outflow may vary monthly. If
VAQCFG is 2 or 4, the daily values are obtained directly from the monthly values; no
interpolation between monthly values is performed. If VAQCFG is 3 or 4, the units of the input
concentrations are mg/l; note: this option requires that the "qty" units be pounds (English system)
or kilograms (Metric system).

QUAL-INPUT (Quality Storage Parameters)

SQO: The initial storage of QUALOF on the surface of the PLS.

POTFW: The washoff potency factor for a QUALSD. A potency factor is the ratio of constituent yield
to sediment (washoff or scour) outflow.

POTFS: The scour potency factor for a QUALSD. A potency factor is the ratio of constituent yield to
sediment (washoff or scour) outflow.

ACQORP: The rate of accumulation of QUALOF if QSOFG is positive. If QSOFG is negative, then
ACQORP is the concentration of QUALOF in the surface outflow in mg/I.

SQOLIM: The maximum storage of QUALOF if QSOFG is positive.

WSQOP: The rate of surface runoff that will remove 90 percent of stored QUALOF per hour.

10QC: The concentration of the constituent in interflow outflow (meaningful only if this is a QUALIF).

AOQC: The concentration of the constituent in active groundwater outflow (meaningful only if this is a
QUALGW).

IMPERVIOUS LAND

ATEMP Module that estimates the surface air temperature over the land segment by correcting for
elevation differences between the gage and the land segments.

ATEMP-DAT (ATEMP data)

ELDAT - The difference in elevation between the temperature gage and the impervious land segment;
it is used to estimate the temperature over the impervious land segment by application of a lapse
rate. It is positive if the impervious land segment is higher than the gage, and negative if the land
segment is lower than the gage.

AIRTMP - The initial (i.e., at the starting time of the RUN) air temperature over the land segment.

IWTGAS- IWTGAS estimates the water temperature and concentrations of dissolved oxygen and carbon
dioxide in the outflow from the impervious land segment.

IWT-PARML (IWATGAS Flags)
WTFVFG: A value of 1 means to vary the water temperature regression parameters (AWTF and
BWTF) monthly; 0 means use annual values.
CSNOFG: A value of 1 means the effects of snow accumulation and melt are being considered; if it is
zero, they are not. If section IWATER is active the value of CSNOFG supplied here is ignored
because it was first supplied in the input for that section.

IWT-PARMZ2 (Temperature Estimation Parameters)
ELEV: The elevation of the ILS above sea level (used to adjust saturation concentrations of dissolved
gasses in surface outflow).
AWTF: The surface water temperature, when the air temperature is 32 degrees F (0 degrees C). Itis
the intercept of the surface water temperature regression equation.
BWTF: The slope of the surface water temperature regression equation.

IQUALL Module that simulates water quality constituents or pollutants in the outflows from an impervious
land segment using simple relationships with water yield and/or solids.
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NQUALS (Contains the number of quality constituents to be modeled)
NQUAL.: The total number of quality constituents to be modeled.

QUAL-PROPS (Identifiers and Flags for Quality Constituents)

QUALID: A string of up to 10 characters that identifies the quality constituent.

QTYID: A string of up to 4 characters that identifies the units associated with this constituent (e.g., kg,
(for coliforms)). These are the units referred to as "qty" subsequent tables (eg. Table-type QUAL-
INPUT).

QSDFG: If 1, this constituent is a QUALSD (sediment associated).

VPFWFG: If 1, the washoff potency factor may vary monthly. If VPWFG is 2, the daily factors are not
interpolated between monthly values.

QSOFG: If 1 or 2, this constituent is a QUALOF (directly associated with overland flow). If 1, then
accumulation and removal are performed daily, and the removal rate is dependent only on the
accumulation and storage limit parameters (ACQ and SQOLIM). If 2, accumulation and removal
are performed every interval, and the removal rate also takes into account atmospheric deposition
plus lateral inflows.

VQOFG: If 1 then the rate of accumulation and the limiting storage of QUALOF may vary monthly.

QUAL-INPUT (Quality Storage Parameters)

SQO: The initial storage of QUALOF on the surface of the impervious land segment.

POTFW: The wash off potency factor for a QUALSD. A potency factor is the ratio of constituent yield
to sediment outflow.

ACQORP: The rate of accumulation of QUALOF if QSOFG is positive. If QSOFG is negative, then
ACQORP is the concentration of QUALOF in the surface outflow in mg/I.

SQOLIM: The maximum storage of QUALOF if QSOFG is positive.

WSQOP: The rate of surface runoff that will remove 90 percent of stored QUALOF per hour.

REACHES AND RESERVOIRS

ADCALC Module that calculates values for the variables necessary to simulate longitudinal advection of
dissolved or entrained constituents.

HTRCH Module that simulates the processes that determines the water temperature in a reach or mixed
reservoir.
HEAT-PARM (Correction Factors and Energy Balance Coefficients)
ELEV: The mean RCHRES elevation.
ELDAT: The difference in elevation between the RCHRES and the air temperature gage (positive if
RCHRES is higher than the gage).
CFSAEX: The correction factor for solar radiation (it includes fraction of RCHRES surface exposed
to radiation).
KATRAD: The long-wave radiation coefficient.
KCOND: The conduction-convection heat transport coefficient.
KEVAP: The evaporation coefficient.

HEAT-INIT (Initial Temperature Conditions)
TW: The initial water temperature in the RCHRES.
AIRTMP: The initial air temperature at the RCHRES

GQUAL Module that allows the model user to simulate the behavior of a generalized constituent. The
constituent which is modeled may be present in the RCHRES only in a dissolved state, or it may
also be sediment-associated.
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GENDATA (General Input Data Information)

NGQUAL: The number of generalized constituents (quals) being simulated.

TEMPFG: Indicates the source of water temperature data; 1 means a time series (either input or
computed), 2 means an annual value, and 3 means 12 monthly values.

PHFLAG: Indicates the source of pH data; 1 means a time series (either input or computed), 2 means
an annual value, and 3 means 12 monthly values. Input only if any QALFG(1)=1.

ROXFG: Indicates the source of free radical oxygen data; 1 means a time series (either input or
computed), 2 means an annual value, and 3 means 12 monthly values. Input only if any
QALFG(2)=1.

CLDFG: Indicates the source of cloud cover data; 1 means a time series (either input or computed), 2
means an annual value, and 3 means 12 monthly values. Input only if any QALFG(3)=1.

SDFG: Indicates the source of total sediment concentration data; 1 means a time series (either input
or computed), 2 means an annual value, and 3 means 12 monthly values. Input only if any
QALFG(3)=1.

PHYTFG: Indicates the source of phytoplankton data; 1 means a time series (either input or
computed), 2 means an annual value, and 3 means 12 monthly values. Input only if any
QALFG(3)=1.

LAT: The latitude of the RCHRES. Input only if any QALFG(3)=1. Positive for northern hemisphere.

GQ-QUALDATA (identifiers and Information About Quality Constituent)
DQAL: The initial concentration of the quality constituent.
CONCID: Specifies the concentration units (implied that it is "per liter"), eg. "mg" (/).
CONV: The factor to convert from Qty/volume to concentration units: Conc= CONV* Qty/volume (in
English system, volume is in ft%) (in Metric system, volume is in m°).

GQ-GENDECAY (Parameters for General Decay)

FSTDEC: The first order decay rate for the quality consituent.
THFST: The temperature correction coefficient for first order decay.
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